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Actions 
 
Definition: An action, defined in the “Actions” palette, is a recording of a sequence of Photoshop work 
steps, e.g., menu commands, tool operations, or other editing functions, that can be played back in whole or 
in part anytime the user needs to repeat the same exact process. In other programs this is often referred to as 
a Macro. Below is a basic workflow for building and using Actions: 
 

 
 

 
 
Actions are closely related to the File menu “Automate/Batch” and “Automate/Create Droplet” commands, 
which allow an action to be performed over a group of image files. Batch works within the Photoshop 
environment and Droplets can be executed from outside Photoshop directly in the Windows workspace. 
 

1. Actions are stored in files with the “.atn” filetype. In Windows XP, for Photoshop 7, it is in the 
Program files/Adobe/Photoshop 7/Presets/Photoshop Actions directory.  

2. You can record your own actions or use pre-written actions that come with Photoshop, that can be 
downloaded from various web sites, or that you can purchase. 

3. You can learn techniques by looking at other’s actions to see how they accomplish a particular 
task. 

 



Actions V2 2 Rob Dublin 

 
 
 

4. Typical of most Photoshop palettes,  the Actions palette is composed of three main sections: the 
command menu arrow button, the body, and the icon strip along the bottom. 

a. The command menu arrow on the top right is accessed by clicking the Command Button 
(see illustration above).  

b. The body, in list mode, displays a list of available actions; in button mode, it displays 
buttons with actions that are invoked when pressed. 

i. Check box on left shows what command should be included when the action is 
run. You can use this to eliminate steps to adjust an action to a particular 
situation (e.g., leave off a file save command when just wanting to apply effect 
but not save). 

ii. The second column with a little dialog box icon turns the modal menu entry on 
or off, so that you can enter new info in any operation that that presents a dialog 
box(on), or just accept the set values (off)  

iii. Main area displays a list of action sets, which are groupings of actions, as well 
as the actions themselves. The arrow keys in front of an entry allow you to 
expand or contract that entry. You are able to view all the details of a particular 
step at the lowest level. 

iv. At the bottom of the pallet are buttons that perform key tasks. From left to right: 
1. Square icon stops recording. It is gray when you are not recording, blue 

with cursor over it when you are in recording mode. 
2. The circle starts recording. When not recording it is blue when the 

cursor is over it. If clicked it turns red to indicate that you are 
recording. 

3. Arrow plays back selected action or action step. 
4. Folder icon creates a new action set. Input is the set name. 
5. Document icon creates a new action within set. Input is action name. 
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6. And the trash can is the trash can. Drag an item to delete either set, 
action or step. 

5. Command menu is activated by pressing the arrow on the top right. 
a. Dock to Palette Well puts the actions palette back on the well at the top of the screen. 
b. When Button Mode is checked, actions appear as color-coded buttons. This is useful 

when you want to have handy access to your actions, which can be invoked by the simple 
click of a button. However, you cannot create or edit actions in button mode. 

c. The second set of menu items deals with basic Action operations: 
i. New Actions and New Set do what the similar buttons on the bottom of the 

palette (see figure above) and create either a new action or action set, which is 
just a container for a grouping actions for accessibility, and for storing and 
retrieving actions from files. 

ii. Duplicate will duplicate the highlighted item (the selected item) on the list, 
whether it is a whole action or just a single step. Note that you can hold down 
the Ctl key and select multiple items to be acted upon by this and similar 
commands. 

iii. Delete removes the selected item(s) from the action or the whole action, or even 
multiple actions. 

iv. Play command plays an action, i.e., sequentially goes through each recorded 
step in an action. The Action must be checked – included -- in the first column 
of the palette body or only those items in the action that are also checked will be 
executed. In this manner you can selectively omit steps from actions for specific 
circumstances. You can also play an action by clicking on the play icon at the 
bottom of the palette (see Fig. above). 

d. The next set of menu choices have to do with recording an action. 
i. Start Recording begins the recording of an action. You can also do this by 

clicking on the round button at the bottom of the palette (see Fig. above). In 
recording mode you actually use Photoshop tools,  menu commands, and other 
editing functions and they are recorded as you work. To stop, just press the left 
square button on the bottom of the palette (see Fig.). There is no Stop command 
on the command menu. 

ii. The Record Again command allows you to go back over an action (highlight the 
one you want to change) or just a selected step. You can change settings and tool 
modalities, etc. this way.  

iii. Insert Menu Item command is used add work steps that are normally not 
recordable, like painting and toning tools, tool options, view commands, and 
window commands. To use this select the step after which you would like to add 
an item. The click on the Insert Menu Item command. An Insert Menu Item info 
dialog box appears. You now choose the menu item you would like to inset, e.g., 
click on View/Show/Grid and then click the OK button on the Insert menu 
dialog box. Voila, an add grid step is inserted into the action. You won’t see the 
grid until the action is executed, however, so the actual workspace is not 
affected by adding the menu item. 

iv. Insert Stop allows you to stop the processing of the action, present the user with 
information in a dialog box. At the stop, you can do some work, like painting 
with a brush. After you press the Stop button in the dialog box, processing stops 
at the next step following the stop. To continue with the action you must press 
the continue arrow key. When you create the Stop, you can check the Continue 
box, and processing will automatically continue after the stop if you press the 
Continue button in the Message dialog box.  

v. Insert Work Path does what it says. It inserts a named work path into the Action. 
After you click on this command, go to paths and select the path to insert. 

e. The fourth grouping consists of two commands that control Action and Playback mode 
options. Action Options allow you to change the name, assign an action to a function key, 
or change the color of the button in button mode. Playback Options allow for Accelerated 
(normal mode), Step by Step (complete each command and redraw the image before 
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going on to the next command), or Pause for a timed interval, which you can specify) for 
playback. The latter two choices are for debugging, but in my opinion are not too helpful. 
Inserting stops after a problem command is a better way. 

f. The next set of Command Menu choices deal with operations that get Actions into and 
out of the desktop environment. 

i. Clear All Actions deletes all actions from the Actions palette. 
ii. Reset Actions restores the palette to the default set. 

iii. Load Actions loads an action set from a file. The default location for actions 
varies with operating system but is in the Presets/Photoshop Actions folder. 

iv. Replace Actions does what it says and will replace an existing palette action 
with one stored in a file. 

v. Save Actions allows you to save an Action Set (not an action) as a file with 
filetype “.atn”. You must have a set highlighted for this command to work. Note 
that if you press Ctl+Alt when you click this command, the set will be saved as a 
text file. You can print and review it, but you can’t reload it. 

g. Under the last bar in the menu is a list of all the Action Sets in the Presets/Photoshop 
Actions folder. Double clicking on an item. 

6. The Batch command, which is accessed by selecting File/Automate/Batch from the top function 
menu, plays an action over all files in a directory, all open files, selected files from the file 
browser, or all files imported from, e.g., a camera or a scanner. For the last method to work 
properly, your camera or scanner software must be written to work with this Photoshop facility. 
The Batch menu for Photoshop 7 is shown below: 

 

 
 

a. The Play section at the top is where you indicate what Set and what Action in that set you 
want to play via the Batch automation utility. 

b. The Source section is where you indicate what objects you want the batch command to 
operate on. The drop down menu gives you the choice to select: Folders (shown in Fig.), 
that is, the directory where the source files live; Import, which is really an external source 
like a camera or scanner (on my system only PDF is listed as a valid source, not 
surprising since this is another Adobe product and interoperability should be a given); 
Open Files to play the action only on files already open on the desktop; or File Browser, 
where currently selected directories or files are used as the Source.  
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i. The Choose button is where you select the Source directory if you chose the 
Folders option. 

ii. The Override Action “Open” Commands is a very important check box. If you 
choose folders, you must check this to have the Batch open files in the source 
directory, not the one listed in your open command. It is also important to have 
an Open command in your action as Batch will not automatically insert one for 
the folders choice. If you want to use Open Files or the File Browser, then 
deselect this checkbox and disable (uncheck) the Open command in your action. 

iii. Check Include All Subdirectories if you have nested subdirectories you want to 
work with. 

iv. The Suppress Color Profiles checkbox is useful to suppress warnings and allow 
the batch process to run without interruption. 

c. The Destination setting allows you to select as target for the results of the Action: None 
leaves files open after processing; Save and Close will replace the original source files in 
current location;  Folders once again specifies a target directory or folder (make sure it 
exists before running your batch command). 

i. As with Source, click Choose to specify a particular destination directory. 
ii. Select Override Action "Save As" Commands if you want specific file names in 

Save As commands in your action to be overridden with the names of files being 
processed by the batch processor. You need to use Save As and, if you don’t 
want all your source files open on the desktop, Close commands in your action 
to change the filetype of your files, e.g., if you are converting from Tiff to jpeg. 

iii. The File Naming box allows you to build destination file names of your 
choosing, by combining elements from the drop down lists (e.g., Document 
Name, 2 Digit Serial Number) with fixed elements that you just type in. At least 
one element must be unique for each file (like Document Name). 

d. The last section provides two options for handling errors. Choose, in the drop down menu 
after Errors, Stop for Errors to halt processing with a pop up dialog after an error is 
detected, or choose Log Errors to a File to write errors to a file but continue processing 
the batch file to completion. The Save As… button allows you to specify the error file. 

e. When you are done, click the OK button on the top right and the Batch command is off 
and running. 

7. Droplets are the same as Batch commands except that they exist outside Photoshop and you apply 
them to files or folders by simply dragging the file(s) or folder(s) onto the droplet (you can select 
more than one file or folder the way you normally do in Windows by Ctl-clicking or Shift-
clicking). Below are the differences from Batch commands. 

a. You create a Droplet by choosing File/Automate/Create Droplet… 
b. Select Choose in the Save a Droplet In section to pick a folder where you want the 

droplet to live. It can be moved at any time. 
c. You don’t get to choose a Source directory as you do for Batch, because the source, as 

indicated above, are the file(s) or folder(s) you drag and drop on the created Droplet. 
d. All other information is the same as for Batch commands  

8. Scripting is a facility that allows you to use a program to control the operation of Photoshop. It is 
useful if you need to have logic embedded in your automation that will conditionally process some 
steps. This is really programming and involves Visual Basic Scrip, JavaScript, or Apple Script. 
This is not installed by default; you must install this feature separately after you install Photoshop. 
It is in a separate directory on the installation CD. 


